The United Nations Environment Programme World Conservation Monitoring Centre (UNEP-WCMC) is the specialist biodiversity assessment centre of the United Nations Environment Programme (UNEP), the world’s foremost intergovernmental environmental organisation. The Centre has been in operation for over 30 years, combining scientific research with practical policy advice.

**PARCC Project Training Manual**, prepared by UNEP-WCMC and all PARCC project technical partners (Met Office Hadley centre, IUCN Species Programme, BirdLife International, Durham University, and DICE University of Kent), with funding from Global Environment Facility (GEF) via UNEP.

**Copyright:** 2015. United Nations Environment Programme.

**Reproduction:** This publication may be reproduced for educational or non-profit purposes without special permission, provided acknowledgement to the source is made. Reuse of any figures is subject to permission from the original rights holders. No use of this publication may be made for resale or any other commercial purpose without permission in writing from UNEP. Applications for permission, with a statement of purpose and extent of reproduction, should be sent to the Director, DCPI, UNEP, P.O. Box 30552, Nairobi, Kenya.

**Disclaimer:** The contents of this report do not necessarily reflect the views or policies of UNEP, contributory organisations or editors. The designations employed and the presentations of material in this report do not imply the expression of any opinion whatsoever on the part of UNEP or contributory organisations, editors or publishers concerning the legal status of any country, territory, city area or its authorities, or concerning the delimitation of its frontiers or boundaries or the designation of its name, frontiers or boundaries. The mention of a commercial entity or product in this publication does not imply endorsement by UNEP.

**Citation:** Met Office Hadley Centre. 2015. PARCC Project Training Manual. Module 2. Climate data and scenarios. UNEP-WCMC technical report.

**Available From:** UNEP World Conservation Monitoring Centre (UNEP-WCMC)
219 Huntingdon Road, Cambridge CB3 0DL, UK
Tel: +44 1223 277314; Fax: +44 1223 277136
Email: protectedareas@unep-wcmc.org
URL: [http://www.unep-wcmc.org](http://www.unep-wcmc.org)

**Photo cover:** River Number Two Beach, Freetown Peninsula, Sierra Leone. Copyright: Elise Belle.
Table of Contents

CHAPTER 1. THE CLIMATE SYSTEM – HOW AND WHY THE CLIMATE IS CHANGING ........................................... 4
CHAPTER 2. MODELLING REGIONAL CLIMATE ........................................................................................................ 10
CHAPTER 3. CLIMATE AND BIODIVERSITY: OBSERVED PAST AND PROJECTED FUTURE CHANGES .......... 18
CHAPTER 4. APPLICATION OF CLIMATE INFORMATION FOR ASSESSING ADAPTATION ....................... 28
CHAPTER 5. CLIMATE PROJECTION FOR WEST AFRICA ......................................................................................... 33
CHAPTER 6. PRACTICAL SESSION: USING THE REGIONAL CLIMATE PROJECTIONS ................................. 41
Chapter 1. The Climate System – How and why the climate is changing

The greenhouse effect and its role in climate change

• The greenhouse effect and its role in climate change
• The IPCC and headline results from its 4th Assessment on observed changes
• Global climate models (GCMs), global and regional climate change projections
• Regional climate change projections and predictions
• Observed and projected changes in impacts

The earth’s energy balance

Greenhouse effect schematic

Outline

The greenhouse effect

The earth’s energy balance

Greenhouse effect schematic

Outline

The greenhouse effect and its role in climate change

The earth’s energy balance

Greenhouse effect schematic

Outline

The greenhouse effect and its role in climate change

The earth’s energy balance

Greenhouse effect schematic
The greenhouse effect is essential

If the sun only heated the earth then the temperature of the earth would be about -18° C (about the temperature of your freezer at home).
Carbon dioxide, water vapour, methane and other greenhouse gases in the atmosphere trap some of this heat.
Because the atmosphere traps some of this heat it warms the earth so most of it is above freezing and able to sustain life.

The main cause of current climate change is an enhancement of the greenhouse effect.

Since people have started to use coal and oil for energy for factories, heating and transport they have increased the amount of carbon dioxide by about one third.
The number of people in the world has increased which has needed more farming which has increased the amount of methane in the atmosphere.
Because this has made the atmosphere warmer there is now more water vapour in the atmosphere.
Other causes of climate change include emission of aerosols, land-use change — and natural factors such as orbital changes and volcanoes.

The world has warmed

Globally averaged, the planet is about 0.75° C warmer than it was in 1860, based upon dozens of high-quality long records using thermometers worldwide, including land and ocean.
Eleven of the last 12 years are among 12 warmest since 1850 in the global average.

IPCC (Intergovernmental Panel on Climate Change) 4th Assessment

• IPCC 4th Assessment 2004 – 2007
• 152 Authors
• ~450 contributors
• ~600 expert reviewers
• ~30,000+ review comments
Content:
• Summary for Policymakers – agreed by all governments
• Technical Summary
• 11 Chapters + FAQ
• ~5000 literature references
• ~1000 pages

The IPCC and headline results from its 4th Assessment

The world has warmed
Industrial revolution and the atmosphere

The current concentrations of key greenhouse gases, and their rates of change, are unprecedented.

- Carbon dioxide
- Methane
- Nitrous Oxide

Source: IPCC

Warming is Unequivocal

- Rising surface air temperature
- Rising sea level
- Reductions in NH snow cover
- Also rising ocean and atmospheric temperatures

Source: IPCC

GCMs represent the important physical processes

- Winds, temperature, humidity are represented in GCM atmosphere grid-boxes
- Currents, temperature, salinity are represented in GCM ocean grid-boxes
- Temperature and moisture represented in land surface

Source: IPCC

Water Vapour Feedback

Water vapor responds to changes in climate, but it doesn’t drive changes in climate. It’s a major feedback that amplifies global climate change.

New in IPCC (2007):

- Observed trends that demonstrate the trend, in both the upper troposphere and at the surface.

Source: IPCC

Global climate models (GCMs), global and regional climate change projections

Source: IPCC
GCMs and predicting regional climate change

- 20 modelling centres around the world have built and run GCMs for understanding and predicting climate change
- Modelling experiments are organised by the Coupled Modelling Intercomparison Project (CMIP)
- Models run under the third CMIP (CMIP3) were widely used and assessed in the IPCC AR4
- Currently, models run for CMIP5 are being analysed and assessed as part of IPCC AR5

Understanding and attributing regional climate change

Anthropogenic warming is discernible on all inhabited continents

- Observed
- Expected for all forcings
- Natural forcing only

With A1B emissions (typical "business as usual") the average of CMIP3 global climate model projections has:
- Global mean warming 2.8°C by 2090-2099;
- Much of land area warms by ~3.5°C
- Arctic warms by ~7°C

How unusual would this be regionally?

Significant "predicted" regional temperatures rises in which we have confidence given the models' responses to observed forcing.

Using GCMs to understand the drivers of the warming

- Are observed changes consistent with expected responses to forcings
- With alternative explanations

Most of the observed increase in globally averaged temperatures since 1950s due to the observed increase in anthropogenic greenhouse gases.

What will and what may happen

Warming will increase if GHG increase. If GHG were fixed at current levels, 0.6°C more warming would be expected by 2100.

1.8°C = 3.2°F
2.8°C = 5.0°F
3.4°C = 6.1°F

CO2 Eq
IPCC summary of temperature and rainfall changes from CMIP3 models

ΔT
ΔP
|ΔP|

agreement

The global average SLR for the 20th century was about 17cm, mostly from expansion of the warming oceans with contributions from glacier melt (Alaska, Patagonia, Europe...). Future changes just from these processes could be up to 0.5 m by 2100, and up to 1m within about 2-3 centuries, depending on how much GHGs are emitted. Other processes such as loss of major ice sheets could increase these changes.

Sea level rise in a warmer world

Projected changes in precipitation from CMIP3 and CMIP5

Blue–increase
Brown–decrease
Green–no change

Regional climate predictions and projections

Statements we have confidence in:
Seasonal temperature will increase in all regions – models respond as we would expect to observed forcings
Seasonal precipitation will change in many regions – confident statements can be made where the dominant processes are driven by warming
Sea-levels will rise in all regions – global average range from observations and process understanding, regional range due to model-dependent variability in patterns

Regional climate scenarios

Available regional climate scenarios include clear predictions (temperature, sea-level rise) and projections where we have less confidence (precipitation, tropical storms)

Thus some clear basis for decision-making but this needs to be done using information with different levels of confidence

Most information is derived from global climate models (GCMs) which do not provide sufficient detail at the country level

Observed and projected changes in impacts
It is likely that anthropogenic warming has influenced many physical and biological systems. Note lack of African studies.

Current Land Cover Trends

• Drying trend over W African tropical forest

Water

There is high confidence that hundreds of millions of people will be exposed to increased water stress. Again, note lack of information over much of Africa.

Estimated changes in rainfall during the 21st century

Species: Plant diversity

5197 African plant species for 2025, 2055, and 2085
81%-97% of African plant species are projected to decrease in size and/or shift in location.
25%-42% are projected to lose all of their area by 2085.

Lion demography

Diagram of processes linking energy and environment to lion biodiversity. Solid arrows indicate primary variables; grey arrows indicate secondary variables.

Climate is changing as a result of an enhancement of the greenhouse effect and associated feedbacks. Significant changes have already been observed and these are likely to increase in the future. Global climate models are key to understanding and predicting climate changes. Predictions include increases in temperature and sea-levels in all regions. Projections include changes to seasonal precipitation in many regions. Significant impacts have already been observed and are projected for the future.
Chapter 2. Modelling regional climate

Objective of the session

- Review of different methods used to obtain detailed climatic information from global climate models (GCM) with a focus on regional climatic models (RCM)

Context...

What is climate?

- Climate is not weather. Weather is only predictable for few days in advance and represents rapid fluctuations of the state of the atmosphere.
- The climatic system is a thin superficial layer around the planet that governs the life of humans with its physical properties.
- Climate refers to the average state of the climatic system in a region and time period typically over 30 years, including a statistical description of its variations.
- Variations in climate caused by external factors, can partially be predictable at the scale of regions and continents.

Plan

1. Techniques for the regionalisation of climate
   - Regional climate models
2. International efforts to model climate variations in Western Africa
Techniques for the regionalisation of climate?
• These techniques allow to extract precise information from outputs of GCMs.
• The climate of a region results from interactions of global climate and local physiographic characteristics.
• Impact evaluators need regional climatic details for vulnerability studies and to define adaptations.
• The projections of OAGCM lack regional details because of the coarse spatial resolution.
• Down-scaling with regard to evaluations of climate change is different from down-scaling seasonal climate predictions.

Statistical and empirical techniques
From historic data:
Local variable = ø (large-scale variable(s))
From OAGCM outputs:
Local predicted variable = ø (large-scale variable)
ø is applied to the results of GCM to obtain a future local variable.

Classification
• Statistical
• Climate generators
• Transfer functions
• Climate typology
• Dynamic
• High resolution and variable resolution of AGCM
• Regional climate models
• Statistical/Dynamic

Regional atmospheric modelling: nested in a general circulation model.

Caracteristics of the elastic grid of AGCM
In this place, the spatial resolution is equivalent to one grid cell of roughly 30 km.
This spatial resolution is progressively relaxed with a displacement towards the antipods (close to New Zealand).

Local / Regional: spatial scale required for climate impact studies.
Continental: scale at which the outputs of Global Circulation Models (GCM) are reliable.

Proceed from global to local climate...
Criteria of relevance of the techniques for the regionalisation of climate

- Coherence at the regional level with global projections
- Physical plausibility and realism
- Adequacy of information for impact evaluation
- Representativeness of future climatic changes
- Accessibility for the utilisation in impact studies

Relevance of techniques for the regionalisation

<table>
<thead>
<tr>
<th>Method</th>
<th>Strength</th>
<th>Weakness</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statistical</td>
<td>• High resolution</td>
<td>• Little computing power required for the calculations</td>
</tr>
<tr>
<td>AGCM high-resolution</td>
<td>• Can represent processes that cannot be explicitly resolved at the sub-grid cell scale</td>
<td>• Expensive in terms of computing power</td>
</tr>
<tr>
<td>Regional models</td>
<td>• High (very high) resolution</td>
<td>• Can present extremes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Physical base</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Multiple variables</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• RCM: easily transposable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Physical parameterisation

In climatic models, this terms refers to the technique of representing processes that cannot be explicitly resolved at the scale of the spatial or temporal resolution of the model (that means sub-grid cell scale processes), by relations between the area or average influence of the process at the grid-cell scale and the large-scale circulation.

Uni-directional imbrication

- A RCM is a limited area model (LAM), similar to those used to forecast weather (NWP)
- RCM are forced from the lateral boundaries by GCM outputs or analytical data...
- The deviations between a RCM and the reference GCM have a tendency to be more important towards the surface and the middle of the domain.

Plan

1. Techniques for the regionalisation of climate
   - Regional Climate Models
2. International efforts to model climate variations in Western Africa
## Validation of the climate model

- The validation of the model is **essential**:
  - A simulation could be made in areas where the performance has never been tested.
  - Allows to familiarize one self with the characteristics of the model.
  - It is an indicator of the level of credibility of the RCM outputs and for the best way to make use of the results.

### Types of validation

- These techniques can be applied to four types of validation:
  - 1) GCM vs. observations
  - 2) RCM derived from a GCM vs. GCM
  - 3) RCM derived from a GCM vs. observations
  - 4) RCM derived from observations vs. observations

### Conditions at the lateral boundaries

- Method of relaxation (PRECIS,RegCM)
- Forcing at the large scale with a lateral buffer
- Spectral imbrication (CRCM)
- Large scale forcing of the components with low wave numbers
- Important questions
  - The resolution of spatial reference data
  - Update frequency of the reference data

### Conditions at the oceanic surface boundary

- Two methods to obtain the oceanic surface temperature (OST) and ice thickness:
  - Use a coupled OAGCM
    - Necessary to high-quality simulation of the OST and sea ice in the model
  - Use observations
    - For the simulation of the observed climate.
    - In the case of the simulation of future climates, the observed values with noted changes of the OST and the ice produced by a coupled GCM simulation

### Evaluate the accuracy with which the projecting system reproduces the current climate

- Model system = GCM + RCM
- Question 1: Are the incoherences in the model system?
  - Among the parts of the system
  - Among a part of the system and “reality”
- Question 2: Is yes, why?
  - Systematic bias of the model (errors in the physical concepts underlying the model)
  - Spatial sampling problems (differences in the resolution of the model and observations)
  - Mistakes in the observations (problems with the grid, problems link to instrumentation)

### Conditions at the oceanic surface boundary

- The GCM is onle part of the system and “reality”
- The level of validation depends on the experimental design. For example:
  - Sensitivity or process analysis based on observed boundary conditions
  - Climatic changes: 2) and 3), maybe 1)
2) Evaluate the coherence between RCM and GCM

- Question: At which point does the RCM become contradictory to the GCM?
- Necessity of including the interannual variability in the comparison
- Examine the seasons separately to confirm the behavior under generally different forcing regimes

3) Evaluate to which extent the RCM reflects the current climate

- Question: At which point does the RCM become contradictory to the GCM?
- Annual output of GCM cannot be compared individually with annual observations (for the same reason that apply to GCM)
- The errors are a combination of the three sources:
  1. Physical errors in the RCM
  2. Error at the boundary conditions (BC)
  3. Physical errors in the GCM

4) Derived experiences from the re-analysis

- The RCMs 'downscaling' show an alternative evolution of model by testing the capacity of the model in the absence of inter-annual errors inherent in GCM
- The BC are those of a GCM in the only atmosphere which is limited to diurnal to seasonal timescales, surface observations, etc. A GCM, i.e., those of a GCM in the only atmosphere which is limited to diurnal to seasonal timescales, surface observations, etc.
- The RCM is broad by reproducing the reality at the current (horizontal) resolutions, all source of the climate warming (GCM) and climate lower data
- Given the possibility of comparisons between RCM and periods of observations at particular events

Intraseasonal variability of precipitation (onset)

- Definition of Onset: At which the main precipitation area migrates north of 10° (using temporally smoothed data averaged over 10 W-10 E)
- The median evolution of May-June-July (MJJ) data in 2003-2007, averaged over 10 W-10 E

Frequency of rainy days for 3 RCMs over the Alpes, in summer, compared to observations

- The Alpes 'breaks' are usually after the mid-summer recession of the rainfall are limited to the same period, etc.
- The RCM is broad by reproducing the reality at the current (horizontal) resolutions, all source of the climate warming (GCM) and climate lower data
- Given the possibility of comparisons between RCM and periods of observations at particular events

Intra-seasonal variability of the Indian Monsoon: active phase/secession of precipitation

- The Alpes 'breaks' are usually after the mid-summer recession of the rainfall are limited to the same period, etc.
Added value of RCMs

RCMs simulate climate in a realistic manner: the case of winter precipitation

Representing smaller islands

Simulate and predict changes in extremes more realistically with higher resolution

Simulate tropical cyclones

Uncertainties of impact scenarios

- Emissions
- Concentration
- GCM
- Regional modeling
- Construction of climate scenarios for impact studies

Necessary stages in the elaboration of climate scenarios
Plan

1. Techniques for the regionalisation of climate
   • Regional Climate Models
2. International efforts to model climate variations in Western Africa

Lessons of recent inter-comparison projects
West African Monsoon Modelling and Evaluation project (WAMME)

The project ENSEMBLES-AMMA

The project CORDEX:

DOMAINES CORDEX (except Arctic & Antarctic)
Conclusions

- The techniques for the regionalisation of climate are used to extract fine-scale climatic information from GCM projections.
- Multiple methods for the regionalisation of climate exist and have mixed advantages (and disadvantages).
- The regional climate model is a tool based on physical and mathematical principles, and is easily accessible to generate climate scenarios of fine-scale spatial resolution.
- Only dynamic methods of prediction of climate changes are capable of providing realistic and coherent climate scenarios.
- The choice of method for the regionalisation of climate adds a degree of uncertainty on top of the evaluation of the effect of climate change on the environment and society.
Chapter 3. Climate and biodiversity: Observed past and projected future changes

What is biodiversity?
- Diversity of all living organisms
- Taxon: Plants, Mammals, Birds, Vertebrates
- Genetic diversity
- Social value
- Environmental value
- Economic value

Why does it matter?
- Proper functioning of ecosystems
  - Food webs
  - Water recycling
- Maintains agricultural systems
  - Pastoral: grazing for nomadic cattle
  - Arable: links to rainfall patterns
- Maintains climate system
  - Stores carbon and moisture
- Economic reasons
  - Sustainable bush meat
  - Tourism
  - Poverty reduction

Ecosystem services
- Social value
- Environmental value
- Economic value
How does climate influence biodiversity?

<table>
<thead>
<tr>
<th>Growth</th>
<th>Decline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expanding climatic niches</td>
<td>Shifting climatic niche</td>
</tr>
<tr>
<td>Reproduction</td>
<td>Invasion species</td>
</tr>
<tr>
<td>Dispersion</td>
<td>Extreme events – drought, floods</td>
</tr>
<tr>
<td>CO₂ fertilisation</td>
<td>More dependence between species</td>
</tr>
<tr>
<td>More efficient water use</td>
<td>Large-scale ecosystem change</td>
</tr>
</tbody>
</table>

Exercise

- What species occur in your country?
- What are the benefits of biodiversity in your country?
- How might these species depend on or affect the climate?
Historical changes in biodiversity

Has the climate influenced biodiversity in the past?

Evidence of change

- In Northern Hemisphere, northern and upper elevation boundaries moved, on average, 6.1 km per decade northward or 6.1 m per decade upward (P < 0.02) (Parmesan & Yohe 2003).
- Phenological responses give estimates of advancement of 2.3 days per decade across all species (Parmesan & Yohe 2003).
- 5.1 days per decade for those species showing substantive change (Root et al. 2003).

Changes in phenology

- Temperate regions (esp. Europe and N. America) have robust long term records.
- Butterfly populations sensitive to spring temperatures.
- Japan cherry blossom records (Menzel & Dose, 2005):
  - 1400-1900 no significant trend
  - statistically significant change point early 1900s
  - steady advancement since 1952
- April-August temperatures explain 84% of the variation in European grape harvest.

Approaches

How to relate biodiversity to climate
Approaches

- Bioclimatic Envelope Models (aka Niche Models, Species Distribution Models)
- Extremes / thresholds that maybe relevant to ecosystems
- Dynamic Global Vegetation Models

Shifting bioclimatic niches

- Hof et al. 2011

What's missing?

- Climate variability – decadal / inter-annual / seasonal
- Dispersal ability
- Population dynamics – interaction / competition
- Adaptive capacity – mechanistic responses
- Response to elevated CO2
- Non-climatic factors
- Disturbance
- Species – area curve assumptions

Bioclimatic Envelope Models

- Loss of 51% to 65% of South African Fynbos biome area, and 33% of species could suffer complete range dislocation by 2050s

Approaches

- Bioclimatic Envelope Models (aka Niche Models, Species Distribution Models)
- Extremes and thresholds that maybe relevant to ecosystems
- Dynamic Global Vegetation Models
**Extremes and thresholds**


**Freshwater runoff**

Fire frequency

Forest cover

Δ

Hartley and Buontempo, 2010. Met Office Consultancy Report for WWF


**What’s missing?**

- Sensitivity to threshold exceedance?
- Mechanistic responses – will species adapt?
- Micro-climate inertia, or rapid change due to fire?
- Hysteresis

**Approaches**

- Bioclimatic Envelope Models (aka Niche Models; Species Distribution Models)

- Extremes / thresholds that maybe relevant to ecosystems

- Dynamic Global Vegetation Models

**Dynamic Global Vegetation Models**

- Interactions between atmosphere and land surface
- Competition between plant functional types
- Cox et al. 2004 “Amazonian forest dieback under climate-carbon cycle projections”
  - Atmosphere-land interactions
  - Simple competition between plant functional types
  - Possible drying trend in parts of Amazon

**What's missing?**

- Sensitivity to threshold exceedance?
- Mechanistic responses – will species adapt?
- Micro-climate inertia, or rapid change due to fire?
- Hysteresis

**Dynamic Global Vegetation Models**

What’s missing?

- Intended to characterise land-atmosphere interactions
- Limited number of PFTs
- Validate poorly against land cover observations
- Difficult to communicate uncertainties to non-specialists

Large Scale Terrestrial Ecosystems: Holdridge Life Zones

- Combination of:
  - Biotemperature – average growing season temperature
  - Annual precipitation
- Can be used to classify:
  - Latitudinal zones
  - Altitudinal zones
  - Potential vegetation
- Magnitude of change between present and future climates

Projections for W African biodiversity

How might climate impact on biodiversity in the future?

Large Scale Terrestrial Ecosystems

Potential vegetation: GHG emissions reductions can have a big impact on potential vegetation change

High emissions 2080s
Low emissions 2080s

V. high agreement
High agreement
Med agreement
Low agreement

Large Scale Ecosystem Changes
Large Scale Ecosystem Changes

Projected biome shifts in West Africa for 2050, derived from 17 general circulation models (GCMs). The area under the receiver operating characteristic curve (AUC) value indicates model performance and is given for the consensus projection for each biome.


Species: theoretical responses


Species: Plant diversity


81%-97% of African plant species are projected to decrease in size and/or shift in location. 25%-42% are projected to lose all of their area by 2085.

Important Bird Areas


5197 African plant species for 2025, 2055, and 2085.

Questions and answers

Any questions?
How to support adaptation to climate change

- Understand:
  - Existing climate-related vulnerabilities
  - Climatic extremes and why they occur
  - How species ranges may shift in response to climate change

- Monitoring, early warning and seasonal forecasting

- Climate projections and uncertainties

- Support land use planning

Understand: Better biodiversity data

- Improved understanding of
  - Drivers of species’ and ecosystems’ sensitivity to change
  - Effects of natural variability on species abundance

Climate Projections: the future

Climate Projections: IPCC 4th Report

Monitoring and early warning
**Land use planning**

- 70-90% of Sahelian and Sudanian precipitation from Mesoscale Convective Systems (MCS)
- African Monsoon Multidisciplinary Analysis (AMMA)

**Observed Sahel rainfall (mm per day) during 20th Century (Hulme 1992)**

**Climate Change Adaptation Strategies**

- Recent advice for IBA adaptation (Hole et al., 2011)
- 5 potential scenarios of emigration / colonization / persistence

**Table:**

<table>
<thead>
<tr>
<th>Category</th>
<th>Emigrating</th>
<th>Colonizing</th>
<th>Persisting</th>
</tr>
</thead>
<tbody>
<tr>
<td>High persistence</td>
<td>Low</td>
<td>Low</td>
<td>High</td>
</tr>
<tr>
<td>Specialisation</td>
<td>High</td>
<td>Low</td>
<td>High</td>
</tr>
<tr>
<td>Increasing turnover</td>
<td>High</td>
<td>High</td>
<td>Low</td>
</tr>
<tr>
<td>Increasing value</td>
<td>Low</td>
<td>High</td>
<td>High</td>
</tr>
<tr>
<td>Increasing diversification</td>
<td>Intermediate</td>
<td>Intermediate</td>
<td>Intermediate</td>
</tr>
</tbody>
</table>

**Land use change**

- Asian rice cultivation
- Impacts of land cover change on regional weather patterns
- Experiments to support long term land use plans
- Support for REDD+

**SALU land use model**

<table>
<thead>
<tr>
<th>Year</th>
<th>Fuelwood</th>
<th>Pasture</th>
<th>Cropland</th>
<th>Fallow</th>
<th>Unused</th>
</tr>
</thead>
<tbody>
<tr>
<td>1961</td>
<td>72</td>
<td>40</td>
<td>35</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1996</td>
<td>14</td>
<td>16</td>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2015</td>
<td>5</td>
<td>14</td>
<td>22</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Graph:**

- Trend over time
- Area of influence
- Spatial distribution


**Climate Change Adaptation Strategies**

- Recent advice for IBA adaptation (Hole et al., 2011)
- 5 potential scenarios of emigration / colonization / persistence
Climate Change Adaptation Strategies

5 potential scenarios of emigration / colonization / persistence:

- Habitat restoration and creation
- Disturbance regime management (e.g. Fire, flood, grazing)
- Translocation – assisted emigration
- Increase site extent
- Managed landscapes for easy migration

Hole et al, 2011
Chapter 4. Application of climate information for assessing adaptation

Outline

- Examples of available climate change information
- The decision-making context
- Climate information requirements
- Using detailed climate change information to motivate response strategies
- Exploring adaptation options using detailed climate change information

Examples of available climate change information

Understanding and attributing regional climate change

Anthropogenic warming is discernible on all inhabited continents

Observed

Expected for all forcings

Natural forcing

Regional temperature changes to 2050 compared to observed change

With A1B emissions (typical "business as usual") the average of CMIP3 global climate model projections has:
- Global mean warming 2.8°C by 2090-2099;
- Much of land area warms by ~3.5°C;
- Arctic warms by ~7°C.
Sea-level rise in a warmer world

The global average SLR for the 20th century was about 17 cm, mostly from expansion of the warming oceans with contributions from glacier melt and ice sheets. Other processes such as loss of major ice sheets could increase these changes.

Future changes just from these processes could be up to 0.5 m by 2100, and up to 1 m within about 2-3 centuries, depending on how much GHGs are emitted.

Other processes such as loss of major ice sheets could increase these changes.

Source: IPCC

Projected changes in precipitation from CMIP3 and CMIP5

Blue – increase
Brown – decrease
Green – no change

Source: IPCC

Drivers of changes in natural and human systems

- Identifying climate change as a potential threat (or opportunity) motivates the examination of the sensitivity of systems to climate (change)
- (Note that this can often lead to the realisation that systems are vulnerable to climate variability and would benefit from the application of climate information, e.g. such as seasonal forecasts)
- Systems are generally sensitive to a range of non-climate drivers and their importance relative to the climate drivers needs to be assessed

Source: IPCC

Other drivers and barriers to action

- Decision-making can be constrained by practical considerations such as time scales which require decisions to be taken with far from ideal information
- This implies that both clear statements of the limitations of information are important as well as the willingness to engage in decision-making using incomplete or poor information
- Barriers can include the structure of institutional frameworks and inappropriate communication channels

Source: IPCC

Climate information requirements

The decision-making context

© Crown copyright   Met Office
Impacts and adaptation assessment information needs are broad and often detailed.

Applications for climate information are diverse, for example:

- Management of transport infrastructure
- Hydrology/hydraulic modelling for urban flood prediction
- Defining drought indices for climate change impacts on crops
- Storm-surge modelling for coastal protection

The information requirements for these applications be very different and as will the quality of the available climate data.

Understanding characteristics of rainfall information for predicting crop yields:

- Seasonal rainfall totals for the two years are similar
- Total yield in 1975 is 50% higher than 1981
- Implies important to capture timing of rainfall within the season (as relevant to crop development)

Applying a 1km grid-based river flow model over the UK:

- 1km resolution required to represent UK rivers
- Requires hourly precipitation and daily potential evaporation
- Precipitation disaggregated from 25km RCM grid using statistical relationship derived from 1km observed rainfall
- Example output: River flows over part of the UK (deeper colours indicating higher rates)

Change in ground-nut yields over India:

- Ratio of simulated to observed yield (1961-1990)
- Percentage change in mean yield for 2071-2100 relative to 1961-1990
- Crop studied sensitive to temperatures above 28°C – thus daily maximum temperature required in modelling yields as well as precipitation, humidity, solar radiation etc.

Implications for information needed when assessing climate impacts:

- Multiple climate variables are often needed
- Information can be required at high temporal and spatial resolution
- Temporal details can involve the daily timescale to capture maxima/minima and sub-seasonal variability
- Fine spatial details are often needed to be able to realistically represent the physical system being studied
- Thresholds of some of the climate variables can be important

Using detailed climate change information to motivate response strategies:

- Crop studied sensitive to temperatures above 28°C – thus daily maximum temperature required in modelling yields as well as precipitation, humidity, solar radiation etc.

Implications for information needed when assessing climate impacts:

- Multiple climate variables are often needed
- Information can be required at high temporal and spatial resolution
- Temporal details can involve the daily timescale to capture maxima/minima and sub-seasonal variability
- Fine spatial details are often needed to be able to realistically represent the physical system being studied
- Thresholds of some of the climate variables can be important

Using detailed climate change information to motivate response strategies:

- Crop studied sensitive to temperatures above 28°C – thus daily maximum temperature required in modelling yields as well as precipitation, humidity, solar radiation etc.
Large temperature changes expected over land areas

- High resolution modelling delivers consistent message on large warming over land even with different sea temperature changes
- Temperature changes >3K by 2080s under the B2 scenario

The message on precipitation change is less clear

- Precipitation changes of up to +/- 20% by 2080s under the B2 scenario

Impact on Caribbean crops of a 2°C temperature rise

<table>
<thead>
<tr>
<th>Crop</th>
<th>Temperature Change (°C)</th>
<th>% Change in Precipitation</th>
<th>Yield (kg/ha)</th>
<th>Change in Yield</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rice</td>
<td>0</td>
<td>0</td>
<td>3395</td>
<td>-10%</td>
</tr>
<tr>
<td></td>
<td>+2</td>
<td>+20</td>
<td>3014</td>
<td>-16%</td>
</tr>
<tr>
<td></td>
<td>-20</td>
<td></td>
<td>2888</td>
<td>-14%</td>
</tr>
<tr>
<td>Beans</td>
<td>0</td>
<td>0</td>
<td>1184</td>
<td>-14%</td>
</tr>
<tr>
<td></td>
<td>+2</td>
<td>+20</td>
<td>1093</td>
<td>-16%</td>
</tr>
<tr>
<td></td>
<td>-20</td>
<td></td>
<td>1033</td>
<td>-19%</td>
</tr>
<tr>
<td>Maize</td>
<td>0</td>
<td>0</td>
<td>4511</td>
<td>-23%</td>
</tr>
<tr>
<td></td>
<td>+2</td>
<td>+20</td>
<td>3779</td>
<td>-17%</td>
</tr>
</tbody>
</table>

Response of crops to the range of projected changes in IPCC AR4

- General signal of little change or increases at high lat. and decreases at low lat. (with and without CO2 effect)
- One possible response thus to change global crop distributions

Exploring adaptation options using detailed climate change information

- 1) Adapting agriculture to climate change
  - a) How climate will change?
  - b) What is the impact on the crops?
  - c) Do suitable options for adaptation exist
- 2) Adapting infrastructure to climate change
  - How climate will change?
  - Can the infrastructure cope with the changes?
  - If not what options are available?
Genotypic adaptation to high temperature stress

- Hadley Centre PRECIS model, A2 (high emission) scenario 2071-2100
- Impact of climate scenarios on number of years when greater than
  - 50% crop failure for temperature sensitive and tolerant variety

Sensitive variety

Tolerant variety

Challinor et al (2007b)

Assessing adaptive capacity using crop-climate ensembles: India

- 180,000+ crop simulations, using ensemble climate changes and the resulting crop responses
- Simulations suggest:
  - 30% increase in thermal time requirement may be needed
- Field studies suggest:
  - 14 to 40% increase available within current germplasm
  - => some capacity for adaptation

Field studies suggest:
14 to 40% increase
available within current germplasm
=> some capacity for adaptation

Challinor et al. (2009a)

Questions and discussion

Climate-proofing the Thames barrier

- Derived river network
- Thames Basin
- Raingauges

Hadley Centre, POL, CEH assessed future London flood risk
- Peak flows by 2080 may increase by 40%
- Maximum estuary water levels may rise by 2.7m by 2080
- Current protection sufficient to 2030, then review decision

Summary

- Seasonal temperature and sea-levels will increase in all regions and seasonal precipitation will change in many regions
- Clear basis for decision-making but need to work with information with different levels of confidence
- More detailed information is often required, is sometimes available or can be generated
- This allows assessment of impacts and adaptation options and thus can motivate response strategies

© Crown copyright, Met Office
Chapter 5. Climate projection for West Africa

Objectives for this morning

1. Summarise West African climate
2. Learn about Regional Downscaling
3. Understand results from the African RCM
4. Practical session on extracting and analysing results

Main drivers of the West African Climate

- Seasonal shift in the Inter-Tropical Convergence Zone
- Sea Surface Temperatures in Gulf of Guinea
- Connected to Asian monsoon and pacific warm pool
- El Nino
- Land use

The West African Climate

West African Monsoon

Climate Projections for West Africa

Andrew Hartley, Met Office: PARCC national workshop on climate information and species vulnerability to Climate Change, April 3-5, 2013
**Local land use**

**Why downscaling?**

- **Main reason:** GCM lacks regional details due to coarse resolution for many climate studies → needs fine scale information to be derived from GCM output:
  - Smaller scale climate results from an interaction between global climate and local physiographic details
  - There is an increasing need to better understand the processes that determine regional climate
  - Impact assessors need regional detail to assess vulnerability and possible adaptation strategies

**What is a Regional Climate Model?**

- Comprehensive physical high resolution climate model that covers a limited area of the globe
- Includes the atmosphere and land surface components of the climate system (at least)
- Contains representations of the important processes within the climate system
  - e.g. clouds, radiation, precipitation

**Lateral boundary conditions**

- **LBCs** = Meteorological boundary conditions at the lateral (side) boundaries of the RCM domain
  - They constrain the RCM throughout its simulation
  - Provide the information the RCM needs to simulate its domain
  - Data come from a GCM or observations
- Lateral boundary condition variables
  - Wind
  - Temperature
  - Water
  - Pressure
  - Aerosols

**From global to local climate ...**

... from a GCM grid to the point of interest.
**Added value of RCMs**

RCMs simulate current climate more realistically.

Patterns of present-day winter precipitation over Great Britain.

**Represent smaller islands**

Projected changes in summer surface air temperature between present day and the end of the 21st century.

**Simulate and predict changes in extremes more realistically**

Frequency of winter days over the Alps with different daily rainfall thresholds.

**Simulate cyclones and hurricanes**

A tropical cyclone is evident in the RCM (right) but not in the GCM.
The modeling process

- December 1949 to December 2099
- 50km spatial resolution
- PRECIS RCM with MOSES 2.2 land surface
- A1B scenario
- African Great Lakes included

Ensemble approach

- Aim: Quantify uncertainty deriving from GCMs in regional climate projections
- QUMP: Quantification of Uncertainty of Model Projections
- 17 GCM ensemble members, each with different model setup
- Sub-selected 5 GCMs to provide LBCs for 5 different RCMs
- Model selection based on regional analysis of GCMs for Africa
- Spread in outcomes produced by the full ensemble
- Excluding any members that do not realistically represent the African climate

Boundary condition selection

- Validation using observations

<table>
<thead>
<tr>
<th>Dataset</th>
<th>Variables used</th>
<th>Resolution</th>
<th>Source</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRU 3.0</td>
<td>1.5m Temperature</td>
<td>0.5° monthly</td>
<td>1900-2006 land only</td>
<td>Gridded station data Mitchell and Jones 2005</td>
</tr>
<tr>
<td>ERA40</td>
<td>850hPa Winds</td>
<td>2.5° monthly</td>
<td>1979-1993</td>
<td>Reanalysis Uppala et al, 2005</td>
</tr>
<tr>
<td>CMAP</td>
<td>Precipitation</td>
<td>2.5° monthly</td>
<td>1979-2002</td>
<td>Gridded station data merged with satellite data Xie and Arkin, 1997</td>
</tr>
</tbody>
</table>
GCM Validation

- No clear ‘better’ or ‘worse’ models across all sub-regions
- Models generally capture timing and location of rainfall well, but magnitudes vary
- Scores are not independent
- Q1, Q5 are coolest, and driest
- Stages 1 and 2 not independent

But, wanted to avoid model Q1, Q3, Q4 and 16 as did not capture seasonal cycles well for one or more sub-regions.

Monsoon Precipitation

- Based on CMAP observations
- June to Sep period
- All models do reasonably well to predict the extent of the monsoon
- Q1, Q3, Q4 and 5 underestimate rainfall amount
- Q6, 9, 12, 14, 15, and 16 slightly over estimate rainfall

Winds and surface pressure

- Based on ERA40 reanalysis

Sub-selection

- Q0, Q2, Q9, Q13, Q14
- Q0 – unperturbed model
- Q2 and Q0 represent cooler end of range of responses
- Q13 and 14 represent warmer range of responses
- Q9 and 14 represent wetter end of range of responses
- Q0 and 2 represent drier end of responses (although this varies seasonally)
Main points

- Large scale geographical distribution of the temperature and precipitation of the African climate are captured.
- The sample captures full range of outcomes produced by the QUMP ensemble and the annual variation for as many of the sub-regions as possible.
- Q0 and Q2 represent the cooler end of the range of future projections and Q13 and Q14 represent the warmer end of the range to provide the spread in temperature.
- No particular model consistently shows the largest change in precipitation for most regions throughout the year.
- Q0 represents the drier end of the range of future projections in Western Sub-Saharan Africa during December, January, February (DJF) but not during June, July, August (JJA) and annually in West Sahel. Q14 actually is the driest model.
- Overall, the analysis suggests that Q0 captures the drier end of the range of future projections and Q9 captures the wetter end of the range.

Key results for West Africa

Precipitation
Chapter 6. Practical Session: Using the regional climate projections

Installation of Software
- Go to the PARCC folder
- Under PARCC/Software double click:
  - R-2.15.3-win.exe
  - diva-gis_setup.exe
- Follow installation instructions for each

Aim of session
To familiarise ourselves with the climate of West Africa, the RCM data, and learn about ways we can plot it, visualise it, and use it

Table of Contents
- Installation of software
- Plots of climate extremes: RClimDex
- Free GIS and species modelling: DIVA-GIS

DIVA GIS
Visualising baseline data

Loading data
- Open DIVA
- Click the “+” button to add all layers from:
  - PARCC/Data/GIS
- This contains the following:
  - Country boundaries
  - Protected Areas
  - RClimDex points
  - Met Station Points from GSOD
- Change the legend of the protected areas:
  - Double click on the layer
  - Under ‘Unique’ tab, select Field ‘iucn_cat’
  - Click ‘reset legend’, and choose colours for each class
Add Labels
- Select layer 'rclimdex_points'
- Go to Layer -> Add Labels
- Choose Field 'name'
- Set appropriate font
- Click 'OK' then 'Close'

RClimDex – What is it?
A user friendly interface to compute indices of climate extremes
Computes all 28 core indices recommended by the World Climate Research Programme for Climate Change Detection Monitoring and Indices
Additionally other temperature and precipitation indices with user defined thresholds

Add baseline climate data
- Source: WorldClim climatic means for each month averaged over 1950-2000 at approx. 0.17 degree
- Go to Tools -> Options
- Click folder, and navigate to PARCC\Data\BaselineClimate
- From dropdown select 'worldclim_10m'
- Click 'OK'
- Go to Data -> Climate -> Map
- Choose file, then click 'Apply'

Analysis of extremes
- Wide range of space and time scales
  - From very small scale (precip) to large scale (droughts)
  - High impact events
  - Unprecedented events (in the available record)
  - Rare events (long return periods)
  - Persistence of weather conditions (droughts)
  - Climatic extremes (e.g. extreme seasons)

Climate Extreme Indices
RClimDex
- What is it?
  - A user friendly interface to compute indices of climate extremes
  - Computes all 28 core indices recommended by the World Climate Research Programme for Climate Change Detection Monitoring and Indices
  - Additionally other temperature and precipitation indices with user defined thresholds

Analysis of extremes
- Wide range of space and time scales
  - From very small scale (precip) to large scale (droughts)
  - High impact events
  - Unprecedented events (in the available record)
  - Rare events (long return periods)
  - Persistence of weather conditions (droughts)
  - Climatic extremes (e.g. extreme seasons)

CCl/CLIVAR/JCOMM Expert Team on Climate Change Detection and Indices (ETCCDI)
- Definition of 28 core extreme indices
- Organization of regional workshop
- WMO-guide on extremes, 2009, targeted at NMHSs around the world

http://www.wmo.int/datastat/docume
tnts/WCDMP_72_TD_1500_en_1.pdf
Running RClimDex

- Make a note of the full path to your PARCC folder
  - E.g. C:/Users/precis/Desktop/PARCC/PARCC
- Open R
- Change directory to PARCC/Software
  ```
  > setwd("C:/Users/precis/Desktop/PARCC/PARCC/Software")
  ```
- Run the script
  ```
  > source("rclimdex.r")
  ```

Loading data

- Click “Load Data and Run QC”
- Navigate to:
  - PARCC/Practical/RClimDex/HadCM3-Q0_PRECIS
- Load “River Gambia National Park.txt”. This is the daily
  RCM data (1949-2099) extracted for the area surrounding
  River Gambia National Park
- Click OK
- Under “Set Parameters for Data QC”, change to 5
  standard deviations

What has RClimDex done?

- Check back in the directory:
  - "PARCC/Practical/RClimDex/HadCM3-Q0_PRECIS"
- RClimDex created new directories
- Check “log” directory
- What does this contain?

Indices Calculation

- Data is now loaded into memory
- Click “Indices Calculation”, and enter the
  following settings
- Next, keep all variables checked, and click OK

Indices Calculation
- After several minutes, a completion message will appear
- Check the “plots” folder
- Use the handout to identify variables
- Which variables could be useful to species in your country?

Next steps
- Review thresholds
- Consider other ensemble members and other locations
- All indices have been calculated. Check...

Interpretation
- Pay attention to scales on y-axis
- Years between 1950-2100 on x-axis
- 1 data point per year

Comparing plots
- Climate as 30 year average
- Natural variability
- Extreme outliers
- Decadal variability may go against long term trend

Quiz Questions!
1. In River Gambia National Park, how would you describe the projections for change in total precipitation for the climate of the:
   a. 2040s?
   Slight decrease, although most ensemble members show little change outside of natural variability
   b. 2080s?
   Significant decreases in all models of approximately 100mm per year
2. In Baudouins and Kiang West, look at maximum number of consecutive wet days (CWD) between 1950-2000. For each ensemble member:
   a. What is the average number of CWD?
   b. What is the range?
3. For Q0, which park has no significant trend in Daily Temperature Range?
4. Which other ensemble members have no trend in DTR for that park?

Quiz Answers!
1. In River Gambia National Park, how would you describe the projections for change in total precipitation for the climate of the:
   a. 2040s?
   Slight decrease, although most ensemble members show little change outside of natural variability
   b. 2080s?
   Significant decreases in all models of approximately 100mm per year
2. In Baudouins and Kiang West, look at maximum number of consecutive wet days (CWD) between 1950-2000. For each ensemble member:
   a. What is the average number of CWD?
   b. What is the range?
3. For Q0, which park has no significant trend in Daily Temperature Range?
   Tanbi NP
4. Which other ensemble members have no trend for that park? All of them (Q0, Q2, Q9, Q13, Q14)